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CLIMATE CHANGE RESILIENCE IN URBAN MOBILITY (IGN.KU.DK/CLIMACCESS) 

METHODS FOR PROCESSING AND ANALYZING UAV-RETRIEVED 

LIDAR AND RGB DATA COVERING SELECTED AREAS IN ACCRA 

 

Technical report prepared by Katerina Trepekli, Bjarne Fog & Lasse Møller-Jensen  

16. Februar 2021. 

1. INTRODUCTION 

A main objective of the Climaccess project is to analyze how extreme rain will affect future urban flood 

patterns in Accra. Within the project, several methods have been developed and tested for identifying and 

mapping high-risk flood locations on both city-wide and local scale. Integrated in the methods is the 

creation of hydrologically correct, digital surface models which form the basis for the modeling of water 

flow and potential flood locations. While the methods used for city-wide flood modelling is described in a 

separate Climaccess technical report, the current report focus on the improved precision of mapping of 

flood prone areas in order to optimize the flood risk assessment at the local scale.  

The report describes methods for generating high resolution digital terrain models (DTMs) featuring 

manmade structures (DTMb) suitable for hydrologic modelling using data acquired by a miniaturized Light 

and Detection Ranging (LiDAR) scanner and an RGB camera obtained by navigating Unmanned Aerial 

Vehicles (UAVs) over urban neighborhoods in Accra. The high resolution DTMbs can be used as inputs to 

a hydraulic/hydrological model covering the drone-surveyed areas in order to detect the exact location, 

extent and depth of local sinks. 

1.1 Background  

Topographic elevation data (Digital Elevation Models-DEMs) of low spatial resolution may introduce 

inaccuracies in flood modelling because meter-wide features of the ground conditions can create a critical 

difference in the simulated flooding (Leitão et al., 2016). Misrepresentation of bridges, tunnels, elevated 

roads, concrete fences, continuous walls, or embankments may result in fault simulations of the direction 

and amount of water flow, by neglecting their important downstream effects on urban water resources 

(Meesuk et al., 2015). Similarly, DEMs of low temporal resolution may constraint the potential of capturing 

dynamic alterations of urban microtopographic features that have a substantial influence on flood 

propagation patterns such as, construction or relocation of structures and infrastructures close to rivers, or 

vegetation removal (Brazier et al., 2015). Thus, to provide a realistic representation of terrain for flow 

modelling and consequently flood risk estimation, topographic data of fine resolution (< 1 m) is required.  
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In principle, UAV LiDAR technology or UAV-photogrammetry can be deployed over any flood-prone area 

to provide precise and cost efficient additional input to the city-wide flood models, thereby providing 

increased accuracy of the flood models where needed. 

Many hydrological models are based on airborne LiDAR/RGB-derived DTMs that represent only the bare 

earth surface (Leitao et al., 2009) or Digital Surface Models that illustrate all the information of surface 

topography, but DSMs featuring terrain, buildings and other manmade features (DTMbs) can generate more 

realistic water pathways. The main challenge of point cloud data obtained by LiDAR scanners is their 

classification to ground, vegetation, buildings, noise, bridges and potentially geomorphologically important 

objects during floods. Most published algorithms for ground return classification utilise morphological-

based (Zhang et al., 2003), slope-based (Vosselman, 2000) or triangular irregular networks (TIN) 

(Axelsson, 2000) filtering algorithms. Compared to a Lidar scanner, a typical camera onboard a drone 

cannot adequately penetrate the canopy in areas where highly dense low or high vegetation occurs. 

However, depending on the flight settings, we can retrieve reliable information regarding the surface 

elevation, in the absence of a UAV-Lidar system.  

In this report a workflow for processing the acquired UAV LiDAR-derived point cloud data and UAV 

imagery using the Structure for Motion (SfM) method (Westoby et al. 2012) is presented.  Four DTMbs of 

0.3 m spatial resolution are produced for four different sites in the Greater Accra. A short description of the 

UAV-surveys set-up is also discussed. The suggested techniques have a strong application potential espe-

cially for optimizing urban flood risk assessment in areas where urban development is rapid and haphazard.  

 

2. MATERIALS 

 

2.1 Study area  

During the last century Ghana has been challenged by severe floods affecting over 3.5 million people and 

causing 567 losses of human lives (www.emdat.be.). The increased frequency of locally intense, short 

duration precipitation events in the Accra region coupled with poor urban planning and flaws in the drainage 

network have resulted in widespread devastating flash floods (Ansah et al., 2020). From 2015 to 2018 

extreme rainfall events concurrent with the peak of rainy season, caused 164 deaths and more than 34.000 

people were displaced with damaged properties. In 2019 only, Accra has experienced four severe flood 

events causing 29 deaths and 4,000 destroyed buildings highlighting the urgent need to better understand 

local flooding in order to deploy early flood-control measures. The selection of study sites exposed and 

vulnerable to flash floods was based on information collected from local politicians, planning officers, 

chairmen and board members of residents’ associations, transport workers. 

 

http://www.emdat.be/
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In August, 2019 four aerial surveys were conducted using the UAV- Lidar and UAV-imagery system 

covering four selected test areas (see also the separate Climaccess technical report on field validation): 

1) Santa Maria locality (16.7 ha) which is a consolidated, highly dense area close to the centre. The citizens 

have low to middle income and flooding has been reported to occur in key sections of roads close to a 

main road. The area includes a steep hill nearby the low-lying urban area (Figure 1). 

2) New Legon Hills (Adenta district) which is a peripheral newly developed area, quite interior with a very 

poor road quality or non-existent roads. The citizens have middle-high income but the impacts of 

flooding were severe plausibly due to flood-prone outlet roads (Figure 2). 

3) Campus of the University of Ghana (hereafter Legon Hall, 14.7 ha), located at the northeast of the centre 

of Accra, characterized as a very flat terrain. (Figure 3). 

4) Okponglo area (25 ha) located in the city center surrounded by main roads and close to the Accra Sports 

Arena (Figure 4). 

 

 
 

Figure 1. Illustration of the acquired high dense point clouds in Santa Maria. The point clouds are coloured 

by elevation. 

 

 

 
 

Figure 2. Illustration of collected high dense point clouds in Adenta.  
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Figure 3. Illustration of the collected high dense point clouds in Legon Hill. 

 

  
 

Figure 4. Illustration of high dense point clouds obtained by the UAV-LiDAR in Okponglo. 

 

 

2.2. Description of UAV-platform 

The applied UAV system consists of a LiDAR scanner (LiDARSWISS, Inc) onboard of a Matrice 600 Pro 

octocopter. The LiDAR system includes: 1) a beam LiDAR scanner (Quanergy M8); 2) an inertial 

navigation system (INS) that fuses data from an Inertial Measurement Unit and GPS data received by a 

Global Navigation Satellite System (GNSS) antenna in order to achieve real-time navigation, high precision 

positioning and attitude; 3) a SONY R10-C camera with 16mm lens;and 4) an integrated data storage unit.  

The scanner can measure and record the angles at which each pulse is emitted and receives the reflected 

pulse from the surface (“return”).  The laser scanner has 8 laser beams and a vertical field of view equal to 

20° (+3°/-17°), resulting in high vertical resolution. The point density (PD) of Lidar returns is a function of 

the: flying altitude above the ground (h in m ), flying speed (u m/s) , scan angle (theta degrees), frequency 

of laser pulse emission (PE Hz), surveyed area rate As=2 u h tan(theta) and roughness of target scanned 
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(PD= PE/ As in points/m2). The mean point density of the point clouds retrieved by the UAV-surveys is 

50 points/m2 (max 400 points/m2). The heading accuracy of the laser scanner is 0.10 degrees, and the 

pitch/roll accuracy equals to 0.05 degrees with an overall accuracy (RMSE) less than 0.03 m. A Trimble 

Real Time Kinematic GNSS Base Station was also used to provide additional overhead of communicating 

with the INS to correct the GPS signals after the flight, offering greater robustness and absolute accuracy 

in the range of just a few centimeters. 

 

2.3. Preparation of UAV-survey in an urban context 

The legal framework for the UAV operation is typically determined based on the weight of the UAV, range, 

as well as the purpose of the flight. All the regulations for UAV operation were followed to minimize risks 

to people and property both in the air and on the ground. Particular concerns included privacy, data 

protection and public safety. Permissions for operating UAV in the four selected sites have been provided 

by the local authorities and local notification to the police and land owners was employed in order to prevent 

conflict with other airspace users or the general public, and to allow monitoring of the flight. Two launch 

areas were located in rooftops of buildings (e.g. Figure 5) and two other in park areas and were all far away 

from roads and other buildings. The access of citizens to the launch areas was restricted to secure their 

safety. The drone use was the responsibility of the UAV pilot who had pilot license granted by the Danish 

aviation authorities. Before the aerial campaign, all sites and take-off locations were visually inspected to 

assess the challenges that local topography (e.g. hilly sites, towers, tall buildings) and environmental 

conditions (e.g. windy conditions) may introduce to the UAV operation. The flights were performed 60 m 

above the ground with a flight speed of 5 m/s, an 80% forward overlap and 65% side overlap specifications. 

The flight horizontal distance was limited by the pilot’s visual line of sight (VLOS). 

A detailed description of the experimental set up including: the flight planning, the connection of the 

LiDAR and the RGB camera with the drone, the set-up of the GNSS base station for correction of drone 

position, instructions for operating the drone and the preprocessing of the raw LiDAR data to point clouds, 

was shared within the project to allow future replication of aerial campaigns in other areas of interest. 

 

 
Figure 5. Take off point in Adenta district. 
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3. METHODS 

 

3.1 Point Cloud Data Processing 

This section describes the processing of point clouds (e.g. Figure 6) for generating high-resolution Digital 

Surface Models including ground (bare-earth surfaces) and buildings (DTMb), but excluding other surface 

features such as vegetation, pedestrians, and vehicles. The generation of the DTMb involves: 

o assembling the flightpaths into one point cloud for each study area; 

o alignment of flightpath for each surveyed site; 

o de-noising of the point clouds;  

o classification of the UAV-LiDAR point clouds into terrain, vegetation, buildings and other man-made 

features, using various image-processing techniques like the morphological (MM) and triangulated 

irregular network (TIN) methods. Removing non-ground points from LiDAR datasets has proven to 

be a challenging task, especially in densely vegetated areas, steep terrain and highly varied terrain like 

urban areas. 

o after-classification removal of of ground and non-ground points including objects like trees and 

bridges to avoid water flow blocking in the simulations. The remaining points are interpolated (e.g. 

using the inverse-distance weighting method) in order to rasterize the point clouds and generate 

DTMbs.  

 

  

Figure 6. Screenshots of the point clouds highlighting the level of detail of data. 

Different approaches are applied and evaluated based on the methods implemented in the software products, 

ArcGIS Pro (ESRI, 2020) and LasTools (Rapidlasso GmbH) the latter of which is a stand-alone software 

product but also included as a toolbox in ArcGIS Pro- and Global Mapper software (Blue Marble 

Geographics, 2020).  The main structure of the workflows in ArcGIS Pro and LAStools is similar: First 
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duplicates and noise are removed from the dataset and then ground and building points are classified sepa-

rately using the TIN approach. The tools included in LAStools have more optional parameters compared to 

the ArcGIS Pro that may have significant effect on the point cloud classification. The Global Mapper was 

utilized to classify the point clouds using the MM approach. The effectiveness of the different algorithms 

to classify the UAV-Lidar derived data is evaluated by comparing the percentage of points grouped to 

different classes with the respective amount of points manually classified.  

 

3.1.1 The TIN method using LAStools 

The LAStools software consists of a suite of tools for filtering, tiling, rasterizing, triangulation and 

converting LiDAR data (Figure 7).  

 

 

Figure 7. The processing steps for the LAStools method. 

 

A detailed description of the tools can be found in the LAStools website. Here we present the main steps 

and configuration that were applied to produce the DTMbs: 

1. LasDuplicate: Removes all duplicate points. In the default mode those are xy-duplicate points that 

have identical x and y coordinates.  

2. LasNoise: The tool attempts to find points that have only few other points in their surrounding 3 

by 3 by 3 grid of cells with the cell that the respective point falls into being in the center.  

3. LasThin. The thinning algorithm places a uniform grid over the points and within each grid cell 

keeps only the point with the lowest (or ‘-highest’) Z coordinate. W kept ‘-random’ points I to 

specify a ‘-seed 232’ for the random generator.  

4. LasGround_new: This is a tool classifies LIDAR points into ground and non-ground points. The 

parameter “step size” defines the average building size, allowing the removal of most buildings. 

Search window sizes from 5m to 25 m at 5 m interval were tested to optimize the number of ground 

points.  For ground classification, the 5 m step size was more effective compared to the 25m cell 

size that was more efficient to classify buildings. For UAV data we should choose the '-all_returns' 

instruction.  The '-bulge 1.0' parameter specifies how much the TIN is allowed to bulge up when 

including points as it is getting refined. The maximal offset in meters up to which points above the 
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current ground estimate get included  were set equal to '-offset 0.1'. Calculation of the parameter 

“compute height” was also selected. 

5. LasClassify: This tool classifies buildings and trees. The TIN approach was more effective in 

classifying the building points using a step size equal to 25m but it generated less ground points 

than the actual exist and could not identify any vegetation points. Different values of maximal 

standard deviation for planar patches ('-planar ' for roofs and '-rugged ' for trees) were tested to 

optimize the number of building and tree points. The '-ground_offset ' was set equal to 1.8, 1.7, 1.6 

and 1.5 m.  

 

The different parameter settings for this tool can be visually evaluated (Table 1). Figure 8a and 8b show 

two screenshots of the classified point clouds using two different settings: a) building planarity 0.2, tree 

ruggedness 0.4 and ground offset equal to 1.8 or 1.7m and b) building planarity 0.1, tree ruggedness 0.4 

and ground offset equal to 1.6 m. A comparison of the results indicates the significance of choosing the 

most suitable filtering thresholds to optimize the classification of point cloud data.  

 

 
 

Figure 8. Screenshots illustrating point cloud data classifies into ground, high vegetation and buildings, 

using different thresholds of roof planarity equal to 0.2 (left) and building planarity equal to 0.10 (right). 

In the second case, more building points were falsely classified as high vegetation (red cycle). 

 

 

3.1.2 The TIN method using the ArcGIS Pro approach 

The standard method in ArcGIS Pro rely on filtering of the point clouds. Figure 9 shows the different tools 

used in the workflow from an unclassified to a classified point cloud. The tools filter the point cloud and 

successively assign class codes to the points in the cloud. At the end of the workflow the point cloud are 

classified as either "overlap", "noise", "ground" or "building", and the remaining points are left unclassified. 

A detailed description of the tools is available online in the manual of the ArcGIS software. The main 

characteristics of each tool are presented below: 

Classify LAS Overlap: The points in an overlap zone (a zone where two or more flight lines cover the 

same area) are marked as overlapping if the distance between points is less than the average distance 

between points in the dataset. 
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Classify LAS Noise: The next step is classification of noise. Returns from flying birds, haze, water bodies 

and reflective mirrors can distort the z-range of the points surrounding that location. Identifying these points 

as noise will allow them to be filtered out from display and eliminated from analysis. Several custom 

defined parameters will control how “aggressive” the noise filter performs. The method used in this tool is 

ISOLATION of points within a neighborhood of 3 x 3 meters.  

 

 

 

 

Figure 9. The processing steps for method in ArcGIS Pro. 

 

 

 

 

Classify LAS Ground: The selection of method (three are available) allows different tolerances for slope 

variation. The STANDARD option is chosen since it has a tolerance for slope variation allowing it to 

capture gradual undulations in the ground's topography. 

Classify LAS Building: The selection of method (three are available), allows different tolerances for 

outliers. The AGGRESSIVE method allows a relatively high tolerance for outliers. The STANDARD 

method allows a relatively moderate tolerance for irregular points. The method used here is the 

STANDARD classification. An example of classified Lidar points is illustrated in Figure 10. 
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Figure 10. Example of classified Lidar points clouds into  

buildings and terrain using the ArcGIS Pro method. 

 

The tools in both ArcGIS Pro and LAStools provide specific interpolation methods to convert point clouds 

into raster format, and options for defining cell size of the output raster. In all cases, the input point clouds 

in LAS format should be classified to ground and building points including boundary walls before 

rasterization (Figure 11a). We can choose the the LAS Dataset To Raster tool in ArcGIS Pro or the 

LAStodem method in LasTools with a step size for interpolation equal to 0.3 m (Figure 11b). The 

interpolation type is Binning and cell assignment is Average. When the cell assignment is chosen to be the 

minimum, the buildings are blurred in the edges. 

 

 

3.1.3 The morphological approach using the Global Mapper 

 

To detect ground points we initially followed a two-part process that removes points that are likely non-

ground based on the local terrain slope and the range of elevation values in the dataset (Vosselman, 2000), 

and then the remaining points were compared to a modeled 3D curved surface inside a series of grids. The 

parametrization of the algorithm included alteration of the values of the bin size and the allowed height 

change from the local averaged minimum, at which points are removed from the ground classification in 

order to model a curved ground surface. To classify buildings and trees we applied a morphological-based 

algorithm which is based on the points’ relationship to a calculated best-fit planar surface inside each bin of 

Lidar data (Global Mapper software). The required minimum height above the ground for a possible 

building or high vegetation point, was set equal to 1.7m. Bridges were detected following a segmentation 

method introduced by Sithole and Vosselman (2006). Point cloud data representing high vegetation, 

bridges, telecommunication towers and cars are excluded from the rest dataset (See example in Figure 12). 

The remaining data are interpolated using the Inverse Distance Weighting method in order to rasterize them 

and produce the DTMbs at 0.3 m high spatial resolution using the MM method (Figure 13 and 14).    
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3.2 From UAV- derived RGB images to a digital surface model (DSM) 

 

Based on UAV-photogrammetry, 3D surface information in the form of point clouds can be generated from 

different viewpoints of overlapping photos taken by a digital camera and using a SfM approach (Westoby 

et al., 2012) to generate topographic data with an accuracy of ±0.5 m approximately. Images are inspected 

for characteristic tie points that are detected in more than one image and based on these points the images 

are aligned in the form of a point cloud using the bundle block adjustment algorithm (Triggs et al., 2000). 

The spatial resolution of the 3-D elevation model is increased and triangulated using the TIN method, which 

is then rasterized.  

In this section we describe a workflow for processing RGB images obtained by a UAV-camera system in 

order to generate high-resolution Digital Surface Models without excluding other features such as 

vegetation, pedestrians, and vehicles. The images are processed using the Metashape software (  AgiSoft 

PhotoScan Professional, 2016) where the main photogrammetry tasks are: the bundle block adjustment, the 

point cloud generation, and filtering in order to generate an orthomosaic. Ground control points in the 

LiDAR dataset were used to reference the coordinate positions of the SfM point-cloud data. A detailed 

description of the image processing can be found in the manual of Metashape software.   

 

3.2.1 Workflow 

1. Load the images: “Workflow -> Add Photos” and then select all images, right-click on one and choose 

“Estimate Image Quality”. Switch to the ‘Detail’ view in the Photo pane to see the quality score from 0 

to 1. Images with scores less than 0.5 should be removed.  

2. Load Camera Positions:  Setting the coordinate system provides a correct scaling of the model. With 

geotagged photos, the coordinates are usually Lat/Long (in degrees); use the convert tool in the 

“Reference” panel to convert to the prefered coordinate system. 

3. Load the associated camera lens distortion profile : “Tools -> Camera Calibration” Optical (barrel) 

distortion will be corrected using the common third degree polynomial approach.  If the information 

about GPS/INS offset with respect to the camera itself is available it should be used as input on GPS/INS 

Offset tab of camera calibration dialog from Tools menu.  

4. Align the images: This step finds image pairs with overlapping scenes. Select Generic, or Reference if 

the images are geotagged. “Workflow” “Align photos”.  

5. Place the markers: To be able to follow the guided marker placement approach the geometry needs to 

be reconstructed. Select Build Mesh command from the Workflow menu and specify ‘’Surface Type 

Height Field’’ and face count: 200000. When geometry is built, visually inspect an image where a 

Ground Control Point is visible in Photo View by double-clicking on its icon on the Photos pane.  Place 

the markers by double-clicking one of the images with a on the image from the “Photos” window and 



12 
 

click on “Create Marker”.  Find the same GCP on one of the other images, and select “Place Marker” 

with the same “Point” number of the former image.  

6.  Input Marker Coordinates: In Import CSV dialog indicate the delimiter according to the structure of the 

file and select the row to start loading from Once all GCP has been marked on all images the marker 

coordinates must be defined Select (Import) in the “Reference” panel.   

7.  Optimize camera alignment: Prior to optimization it is also possible to remove the points with the highest 

reprojection error values using corresponding criterion in Edit Menu → Gradual Selection dialog. Go to 

the “Edit” menu and select “Gradual selection“.The first option is “Reconstruction uncertainty“ where 

it can be set equal to 10. Then to optimize the alignment of the cameras click the wizard’s wand icon. 

8.  Bounding box: The area that needs to be modelled must be included in the selection box using the tools 

for rotating and scaling the box to fit. 

9.  Build Dense Cloud: “Workflow -> Build Dense Cloud”. 

10. Build Mesh: “Workflow -> Build Mesh”. Set Surface type to Height field, and select the dense point 

cloud as Source data. The Face count can be set to Medium, and the Interpolation Enabled.  

11. Build Texture: Select Build Texture from the Workflow menu. For Mapping mode select Orthophoto 

and for Blending mode Mosaic.  

12. Build DEM Metashape: Digital elevation model is generated based on the dense cloud option. Color 

calibration: If the lighting conditions have been changing significantly during capturing scenario, it is 

recommended to use 'Calibrate colors' option. 

13. Build Orthomosaic: Texture mapping can add photographic detail to the3Dsurface based on the original 

images.  The orthomosaic is generated by correcting the individual photographs for relief distortions 

and projecting them onto a planimetric surface with a real-world coordinate system.   

14. Export DEM and Orthomosaic:  “File -> Export DEM”Select Export DEM → Export GeoTIFF/BIL/-

XYZ command from File menu. Similarly, “Export Orthomosaic” → Export JPEG/TIFF/PNG 

command from File menu (Figure 15). If the exported area is large it is recommended to enable Split in 

Blocks feature.  

 

 

4.  RESULTS 

4.1 Generated hydrological corrected terrain models (DTMbs) 

By comparing the performance of the three filtering approaches in the four sites it was found that the TIN 

approach was more an appropriate algorithm for classifying ground points in the hilly site of Santa Maria, 

while the MM filtering was more efficient for classifying the point cloud dataset in the rest flat terrains. 

The results obtained by the LAStools method did not differ significantly from the results obtained by the 

ArcGIS Pro method. The main structure in the workflow is almost the same: First removing duplicates and 

noise from the dataset and then classify ground points and building points separately. In general, the tools 
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included in LAStools have more optional parameters than the tools in ArcGIS Pro. Especially the different 

parameters in the tool LasClassify, where parameters such as ground offset and search area size seem to 

have significant effect on the classification of buildings.  

In Santa Maria the classification of ground and high vegetation was achieved by tuning the TIN model at: 

a 5m step size, a building planarity equal to 0.2 and a value of tree ruggedness equal to 0.4, that over 

performed the MM approach. In the MM approach the optimal set of parametrization that led to a more 

accurate classification consisted of: a minimum height above the local average minimum elevation equal 

to 0.3 m, and a bin size was equal to 0.5 m.  For the morphological filter the optimal RMSE building 

planarity was 0.2 m with the vegetation distance being equal to 0.3 m. 

 

 

Figure 11. a) DTMb at 0.3 m spatial resolution for the Santa Maria site (upper) and b) classified point 

clouds to ground, and concrete manmade features (lower).  
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Figure 12. Digital Surface Model (DSM) of the Legon Hall site including high vegetation features (left) 

and hydrological corrected elevation data DTMb at 0.3 m spatial resolution (right) featuring terrain and 

buildings, and excluding high vegetation. 

 

 

 

 

Figure 13.  Rasterized point clouds classified into ground, and concrete manmade features (DTMb) at 0.3 

m spatial resolution representing the Okponglo site.  
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Figure 14. Hydrological corrected elevation data DTMb at 0.3 m spatial resolution featuring terrain, 

buildings and boundary walls (upper) and classified point cloud data into terrain and manmade urban 

features (lower), both.representing the Adenta site  
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4.2 Orthomosaics of the urban areas surveyed by the UAV-imagery  

 

 

 

Figure 15. Orthomosaics of the areas surveyed by the UAV-camera systems: Santa Maria (upper left); 

Legon Hall (upper right); Adenta (lower left); and Okponglo (lower right). 
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5. CONCLUSION 

As a part of the Climaccess project activities, the testing of the UAV-based technical setup within the 

context of the rapidly urbanizing areas of Accra is seen as an opportunity to contribute to the development 

of the technical and methodological aspects of UAV applications which have the potential for significant 

applied usage in flood prediction and preparation as well as in urban planning in general.  

In this report we described the main steps for generating high-resolution elevation data suitable for 

hydrologic modelling, and by using UAV-LiDAR and UAV imagery. The UAV-LiDAR derived DTMbs 

can be utilized as supplement to satellite or airborne-based data to optimize urban flood risk assessment at 

the local and city-wide scale. The potential of UAV-LiDAR systems to detect complex micro-topographic 

urban features that can be critical to water flow during floods can increase the level of detail of the projected 

flooded areas, securing the most precise and cost efficient drainage and flood protection in settlements 

exposed and vulnerable to the adverse effects of floods. 
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